VECTOR FILES

Made from lines and curves known as
paths, rooted in mathematical theory

Can be scaled and edited non-

destructively (image quality remains the

|deal for:

cutting/etching lines, shapes, text.
all files should be vector unless it’s

a photo realistic etch.
File Types:

drw, .pif, .pct, .ps, .eps, .svf, .svg
[llustrator: .al, .ait, .art
Corel Draw: .cdr, .cdrw, .cdt
Corel: .pat
Digital Line Graph: .dlg, .do
LibreOffice: .odg

Recommended Programs:
Adobe lllustrator, VCarve, Affinity
Designer, Sketch (mac only), Inkscape

vs RASTER FILES

Made from millions of tiny squares,
known as pixels

Scaling and editing is a destructive
process (image quality degrades
with manipulation).
|deal for:
etching photorealistic images,
that’s about it.
File Types:
Jpg, .gif, .png, .tiff, .tif
Photoshop: .psd
Procreate: .procreate

Recommended Programs:
Adobe Photoshop, Procreate, Affinity
Photo, GIMP

How to Save for Laser Use:
Start with a file between 150-300 dpi

Flatten all necessary layers
Image ->Mode ->RGB

Image ->Mode ->Grayscale(Discard
color info)

Image ->Mode ->Bitmap (play with
output and method for best results.
Stay within 150-300 dpi for output
unless you know what you’re doing.
For method, halftone screen is usually
best.

File ->Save as...-> .BMP (1 bit depth)

eps and .pdf files are containers that can hold vector or raster files
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FILE PREPARATION:

a LIGHTBURN

1. Open LightBurn.

2. IMPORT your file. Only OPEN a file if it was previously generated and saved in
LightBurn.

3. Make any necessary adjustments to size, orientation, etc. if needed. Sometimes
the file may import at the wrong size depending on what units it was saved in
(inches or mm). The final gcode sent to the machine is always in mm, so working in
mm is usually preferable to keep things simple.

4. Set any separate layers as necessary by assigning different colors to different
layers. This is done by clicking on the colored boxes at the bottom of the screen
while having a selection in the work panel.

5. Set Line/Fill/Fill+Line as needed in the layers tab (in older versions of LightBurn
these are called Cut/Scan/Scan+Cut).Set all power and speed settings
appropriately according to the chart on the wall. DO NOT set the power above 85,
as this will degrade the laser tube faster.

6. Set the Job Origin in LightBurn (located under the layers tab and the
power/speed tab).

7. Double check all relevent settings, including Scale, Orientation, Speed, Power, Job
Origin, etc.

8. SEND the file to the machine. The machine must be powered on and booted first.
Name the file something uniqgue to help insure there are no accidental file over-
writes on the machine end.

COMMON TIPS AND TRICKS

1. When engraving (Fill), try to align the bulk of the engraving paths along the short
axis (y). This will cut down on job time.

2. If a file is not importing from a thumb drive, try saving it to the desktop and then
import from there. Please delete it from the desktop when you’re finished.

3. If the Fill parts of a file look weird or it is not engraving correctly, double check
that all your paths are closed.

4. Sometimes the settings get set to very specific ones which may not be ideal for
your job. Double-click on the layer and hit “Reset to Default” in the lower left corner
of this panel, then set all your settings accordingly to make sure this doesn’t
happen.

5. Always make sure that Air Assist is turned on in the layer settings. This helps
prevent flare-ups, as well as allowing the material to vaporize properly instead of
burning.

6. Using either Perforation Mode or Dot Mode in Line settings can help minimize
burning on very thin or light materials (fabric, leather, paper, etc.).

7. The machines use 2.5” Focal Length lenses by default. Changing the lens can help
either get better engraving resolution or cut through thicker material. Please ask on
Slack if you are thinking of changing the lens, we're happy to help you pick the
right lens for the job!



MACHINE PREPARATION:

1. Insert RFID card into reader. If the machine does not turn on promptly, make sure
you inserted your card all the way into the reader in one quick motion. If that still
doesn’t turn the machine on, let us know on the #steward lasercutter channel in
Slack (the reader may need to be reset).
2. The machine will calibrate to its’ home position (xO, yO) and then reset to the last
known origin point. ONLY interrupt this process if the machine is making a loud
sound and appears to be trying to move past the laser bed. If this happens,
#steward lasercutter.
3. Make sure that while the machine is booting, the chiller turns on (located under
the central table) and that you hear the fan start up (located behind the laser
machine). The chiller front panel readout should be below 24C, if the temperature is
above that threshold please let the chiller run for up to 5 minutes until the
temperature drops under 24C. Running above 24C can cause damage to the laser
tube. Please do not leave the machine turned on at idle (no laser firing) for longer
than 10 minutes, this can cause condensation in the tube and damage the tube.
4. Place your material in the bed. On the green laser, swap the slat bed for the
honeycomb bed (located between the machine and the wall on the right side) if
you are working with leather, fabric, paper, or other lightweight and/or flammable
materials. *When engraving, please try to align the majority of the engraving area
with the shorter (y) axis. This will decrease overall job time.
5. Using the directional buttons on the front machine panel, place the laser head
over the material surface. Adjust the focal offset (distance from laser head to
material surface) if necessary to make sure the laser head does not collide with
anything below it.
6. Set focal offset.

ba. (Orange Laser) Turn locking screw clockwise to loosen focal lens
enclosure. Using a focal offset gauge, set the focal lens enclosure in relation to the
material surface. If there are no gauges, or you are having trouble getting the focus
right, please refer to the paper test. Once the focal offset is set, tighten the locking
screw counter-clockwise to lock the focal lens enclosure in place.

o6b. (Green Laser) Place aluminum billet underneath the z-height sensor.
Adjust the z-height if necessary by pressing “Z/U” on the front panel, then using
the RIGHT/LEFT arrow keys. Once the billet is in place, make sure you are still in the
Z-adjustment window, then hit “auto focus” at the bottom of the menu. The Z
offset should auto-calibrate. If the aluminum billet is missing, or you are having
trouble getting the focus right, please refer to the paper test.
7. Hit the “File” button on the machine panel (after sending your file over) and
choose your file. Hit Enter.
8. Use the arrow keys to move the laser head to the relevant job origin as was set in
the software. Hit the “Origin” button.
9. Hit the “Frame” button to check the job outline and ensure it fits on your
material.
10. Hit START. Watch the job to make sure it works without problem, and wear your
safety glasses!



SAFETY AND MAINTENANCE
SAFETY:

1. Remove any FLAMMABLE materials from the laser cutter, including small cut-out
bits from previous jobs.
2. Certain materials are dangerous to cut or engrave. Please refer to the safety
sheet for a full list.
3. Be aware when cutting acrylic that any fumes not properly ventilated are toxic to
anyone in the room.
4. Store cleaning acetone away from the lasers as it is flammable.
5. NEVER leave the machine unattended while it is running.
6. FIRE! Small flashes of flame are normal, any continuous flame can damage the
machine. If there is a continuous flame, either the power is too high or the speed is
too low. Pressing the PAUSE button should stop any small flames, if it doesn’t try
the following:
Place the fire blanket over the material,
Use the fire extinguisher if the fire is out of control. This is for emergencies
only and will likely ruin the electronics.
Evacuate the building if a fire is out of control. Call 911 and do not re enter.

MAINTENANCE:

1. Clean the lenses and mirrors with acetone and a microfiber cloth if you notice
they are dirty. Refer to the Lens Cleaning Procedure to properly clean the lens.

2. 1f you notice any sparking or arcing in the rear of the machine, stop it immediate-
ly. Use Slack to notify us if this happens and do not try to resolve it yourself as this
is a HIGH VOLTAGE machine.

3. If the Green Laser makes a grinding sound while adjusting the z-axis, try adjust-
ing the axis in small up and down increments until it moves freely again. Silicon
spray may be applied to the threaded rods under the laser bed to help with this.
Please do not lower the z-axis all the way down, as it will likely seize up if you do
this and need to be manually reset.

4. The mirrors and lenses on both machines need to be periodically re aligned. If
you think they are getting out of alignment (cuts not going through material, a
wide kerf on cuts or etches, etc.) please ask an expert user to align the lenses.

5. The water chillers will need to be topped off every 6 months. If you notice a
chiller running at or above 24C, please turn the machine off immediately and let us
know.

6. If the focal lens or z-axis sensor are changed, the calibration of the z-axis will
need to be re done. Only expert users should recalibrate these settings.

7. Only use the version of Lightburn on the two laser computers to send any files to
the machines. Sending files from an improperly set up version of Lightburn can
corrupt the machine settings, in which case they will need to be rebuilt.



NEVER CUT THESE MATERIALS

Material

DANGER!

Cause/Consequence

PVC (Poly Vinyl
Chloride)/vinyl/pleather
artifical leather

Emits chlorine gas when
cut!

Don’t ever cut this material as it will ruin
the optics, cause the metal of the
machine to corrode as chlorine is released
and ruins the motion control system. It
will also ruin human lungs.

ABS

Melts/ Cyanide

ABS does not cut well in a laser cutter. It
tends to melt rather than vaporize, and
has a higher chance of catching on fire
and leaving behind melted gooey
deposits on the vector cutting grid. It also
does not engrave well (again, tends to
melt). Cutting ABS plastic emits
hydrogen cyanide, which is unsafe at any
concentration.

HDPE/ milk bottle plastic

Catches fire and melts

It melts. It gets gooey. It catches fire.
Don't use it.

Polystyrene Foam

Catches Fire

It catches fire quickly, burns rapidly, it
melts, and only thin pieces cut. This is the
#1 material that causes laser fires!!!

PolyPropylene Foam

Catches Fire

Like PolyStyrene, it melts, catches fire,
and the melted drops continue to burn
and turn into rock-hard drips and pebbles

Epoxy

Burns/ Smokes/ Cyanide

Epoxy is an aliphatic resin, strongly cross-
linked carbon chains. A CO2 laser can't
cut it, and the resulting burned mess
creates toxic fumes ( like cyanidel! ). Items
coated in Epoxy, or cast Epoxy resins
must not be used in the laser cutter.

( see Fiberglass )

Fiberglass

Emits fumes

It's a mix of two materials that cant' be
cut. Glass (etch, no cut) and epoxy resin
(fumes)

Coated Carbon Fiber

Emits noxious fumes

A mix of two materials. Thin carbon fiber
mat can be cut, with some fraying - but
not when coated.

Any foodstuff ( such as
meat, seaweed 'nori’
sheets, cookie dough,
bread, tortillas... )

The laser is not designed to

cut food, and people cut
things that create
poisonous/Noxious s
ubstances such as wood
smoke and acrylic smoke.




Material with Sticky Glue | Coats lens, cracks lens There are many normally laserable items
Backing such as thin wood laminates that you can
purchase that become un-cuttable when
the manufacturer adds a layer of peel-off
glue on the bottom to attach them to
surfaces. Examples include cork tiles, thin
wood laminate, acrylic tiles, and paper
stickers. Never cut these materials in the |
aser cutter if they have this backing. The
glue will vaporize forming a coating on
the lens that will coat it, cloud it, heat it,
and then potentially crack the lens. The
glue residue is worse than resin, and can't
be removed without risking damage to
the lens ... requiring a lens replacement.

Thick ( >Tmm ) Cuts very poorly, discolors, | Polycarbonate is often found as flat, s
Polycarbonate/Lexan catches fire heet material. The window of the laser ¢
utter is made of Polycarbonate because
polycarbonate strongly absorbs infrared
radiation! This is the frequency of light t
he laser cutter uses to cut materials, so it
is very ineffective at cutting
polycarbonate. Polycarbonate is a poor
choice for laser cutting. It creates long
stringy clouds of soot that float up, ruin
the optics and mess up the machine.

WARNING: Because many plastics are dangerous to cut or etch, it is important to know what kind you are planning
to use. Below is a flow chart for determining which material a plastic is. (If you know the specific material you are
planning to use and are unsure of whether it is safe or not, find the Material Safety Data Sheet (MSDS) and confirm
it does not contain chlorine or anything else dangerous).

Sinks

\ Floats

|  Copper Wire Test | Alcohol Test |
| I |

| Watertest |
|

Green Orange Sinks Floats
Fle;m e Flame
PVC HDPE
| Acetone Test ] | I Oil Test I I
Reaction No| Sinks Floats
| Reaction L |
PS LDPE PP
| Heat Test |
Rjacﬁon

PETE



For the water, alcohol (isopropyl), and oil tests, you are simply determining if a very small piece of the material sinks
or floats in the given substance.

The copper wire test: Obtain a piece of copper wire about 5cm long. Handle the wire with pliers, etc. as you will be
applying heat to it. Heat one end of the wire in an open flame until is is red hot and the flame no longer has a green
color toit. Touch the hot end of the wire to the material and get a small amount of material melted off onto the
wire. Place the material over the open flame. If the flame turns green in color, the material contains chlorine and
should not be used.

Acetone test: Find a small container and fill it high enough with acetone to immerse a very small material sample in
the acetone. Let the material sit in the acetone for roughly 20 seconds and remove it. If the sample is soft and sticky,
and the outer layer can be scraped with your fingernail, discard the sample and do not laser cut the material.

Heat test: Submerge a small sample of the material in boiling water for approximately 30 seconds, then remove it. If
it is soft and sticky and can be scraped with your fingernail, discard it and do not laser cut the material.

Materials which can be etched (but not cut)

Glass
Ceramic Tile
Anodized Aluminum

Painted/coated metals
Stone, marble, granite, soapstone, onyx

Marking:

Cermark is the brand name of a marking compound containing molybdenum that costs between $50-$100 for a
120z spray can. It can be sprayed onto stainless steel, brass, aluminum, copper, nickel, glass, or light colored
stone/tile before etching to leave behind a permanent dark black mark. A cheaper alternative to Cermark is Dry
Moly Lube, which containts molybdenum sulfate which breaks down to molybdenum, but does not leave a mark as
consistently dark and uniform as Cermark.




LENS CLEANING AND REPLACEMENT

* The procedure detailed here is for the Hurricane (Green) Laser. Steps for the Orange Laser are
very similar, any differences will be noted in the specific step.”

Bring the head assembly to a convenient spot to work on it, and turn the
machine off. Unscrew the set screw holding the conical tip of the head in
place. *On the Orange Laser, there is no set screw. Loosen the locking
ring (see next step), then turn the loosened tube while holding the conical
tip to unscrew the tip.” Let this part hang free for now.

2. Loosen the locking ring by turning counter-clockwise. On the Green Laser, you
may need a set of channel locks to helo turn it, it tends to hold pretty tight. Once
this is loosened and the conical tip is no longer attached, the laser head may be
removed. On the Green Laser, you may need to twist it with the channel locks to
get it started. Let the z-axis sensor hang free on the Orange Laser once the head
is removed. The removed laser head will look like this --->

3. With the laser head removed, flip it over and you will see a silver locking ring holding the lens
in place. There are two notches in this ring for Ioosenlng and tlghtenmg it, the right sized chisel or
a flat head screwdriver can help get it going: B T )

Be very careful at this stage not to scratch |
or chip the lens, and also not to damage the
notches on the locking ring. Once the ring is
loosened enough, it can be removed by
hand to help avoid scratching the lens. On
the Orange Laser, the locking ring is
recessed further down into the head,

but all other steps are the same for removing it. Before you remove the actual lens, please grad
this black and red tool box, located under the table between the two lasers:

TOOL BOX

ACETONE
Also grab the acetone while you are at it, this will be used to clean the lens.




4. In the toolbox’s lower portion, you will find a lens case like the one below. This should have an
extra microfiber cloth in it. Let the lens fall out of the laser head onto the microfiber cloth.
Wrap the cloth around the lens, and get it
wet with some acetone. Use gentle
scrubbing motions to clean the lens with
the cloth. Be careful not to get any oils
from your fingers onto the two main
surfaces of the lens, as they can cause a
hot spot when the laser fires and crack
' the lens. Holding the lens by the edges
. with your bare hands is fine, but never
touch the two main surfaces with bare
&.;3 hands. Once the lens is clean, it should be
mserted into the laser head SO that the convex 5|de of the lens is facing down when it is all reas-
sembled. So place the lens in convex sde UP, reinsert the locking ring and tighten it being very
careful not to scratch or get finger oil on the lens, then flip the laser head back over so the
convex side of the lens is now facing COWN:

CONVEX UP

LENS

Be sure to tighten the
Sl & locking ring all the way. If
it is loose, or gets loose
it over time, it will rattle
around as the gantries
— > move and produce a very

inconsistent focal point.
S

1 1
CONVEX DOWN

5. Congrats! The hard part is over. Please remember to put the microfiber cloth back in the lens
case, then put the lens case in the tool box and store it all under the table between the lasers.
Also please put the acetone away (if there is no acetone or it’s running low it would be much
appreciated if you either make a note of it, or run over to Kroeger’s to pick some up). Now follow
the instructions on the previous page in reverse to reassemble the head assembly. On the Orange
Laser, one of the focal depth gauges can be used to make sure it is in focus before tightening the
black locking ring. On the Green Laser, make sure there is minimal-to-no spacing between the
locking ring, head, and the piece the holds the z-axis sensor. This will ensure the right focal depth
on the Green Laser. Be careful not to over-tighten the locking rings, as they can get cross-thread-
ed, and remember to reinsert the set screw on the Green Laser!

LASER HEAD

Very little or no spacing

=
—
=
=
=
=
=




PAPER TEST

If the aluminum billet and/or focal gauges are missing, using the paper test is the
next easiest way to set the focal offset for both machines.

1. Find a piece of paper and place it on the surface of your material (or the surface
of another equally thick piece of material if you don’t want to mark up your
material’'s surface).
2. With the laser head over the paper, hit the “Pulse” or “Laser” button on the front
panel. DO NOT hold either of these buttons down, a quick press is all you need. On
the Green Laser, the machine lid will need to be closed before pressing the button.
3. The laser should have briefly fired, creating a hole in the paper. The goal of the
paper test is to get this hole as small as possible.

3a. On the Orange Laser, manually move the focal offset by moving the focal
lens enclosure up or down in small increments. “Pulse” the laser at every increment
to see if the hole is getting larger or smaller when compared to the previous hole
made. When the hole is as small as you can get it the laser should be extremely
close to being in true focus. A small (within .5mm) deviation from true focus in
either direction is fine, it will not noticably impact your results.

3b. On the Green Laser, us the “Z” button and then the UP/DOWN ARROW
KEYS to incrementally move the bed up and down. The machine lid must be closed,
and you must be on the main screen (not the Z axis control screen) for the “Laser”
button to fire the beam. Press the “Laser” button at every increment to see if the
hole is getting larger or smaller when compared to the previous hole made. When
the hole is as small as you can get it the laser should be extremely close to being in
true focus. A small (within .5mm) deviation from true focus in either direction is
fine, it will not noticably impact your results.



